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A. Układ pomiarowy

Elementy układu pomiarowego

Układ śledzenia punktu mocy maksymalnej (MPPT) posiada opisane wejście (Input – moduł 
fotowoltaiczny), wyjście (Load – odbiornik), zaciski zasilania 12 V oraz złącze interfejsu szeregowego (RS-
232). Na wyświetlaczu podawane są informacje zgodnie z rys. 1. Przez interfejs RS-232 układ przesyła dane 
o kolejnych punktach pracy w następującej kolejności:

• numer kolejny punktu,

• moc wejściowa Ppv,

• prąd wejściowy Ipv,

• napięcie wejściowe Upv,

• napięcie wyjściowe UL,

• współczynnik wypełnienia D.

moc wejściowa Ppv napięcie wejściowe Upv

prąd wejściowy Ipv napięcie wyjściowe UL

Rys. 1. Układ informacji na wyświetlaczu układu MPPT

W ćwiczeniu moduł będzie obciążony odbiornikiem o charakterze:

• rezystancji (R) 75 Ω (ze zmianą na wartość alternatywną 50 Ω) – obciążenie elektroniczne 
pracujące w trybie CR;

• źródła napięcia (E – jak np. akumulator) 13,5 V (ze zmianą na wartość alternatywną 12 V) o 
rezystancji wewnętrznej Rint = 0,47 Ω – fizyczny model akumulatora ERCD lub obciążenie 
elektroniczne pracujące w trybie CV z szeregowo połączonym opornikiem.

Obciążenie elektroniczne posłuży również za emulator metody ułamka napięcia rozwarcia.

Obciążenie elektroniczne składa się z modułu głównego (skrajny po prawej, bez zacisków mocujących) i 
dwóch modułów kanałów (z zaciskami mocującymi na dole). Kanały numerowane są od lewej zgodnie z 
kolejnością pojedynczych slotów. W niniejszym ćwiczeniu należy wykorzystać kanał o wyższym zakresie 
napięciowym.

Moduł fotowoltaiczny (PV) posiada po dwa wyprowadzenia bieguna dodatniego i ujemnego. Służą one do 
pomiaru prądu i napięcia w układzie Kelvina, tj.:

• do krótszej pary przewodów (wyprowadzeń napięciowych) może być przyłączony wyłącznie 
woltomierz;

• natomiast wszelkie obciążenia wraz z amperomierzem należy przyłączać poprzez dłuższą parę 
przewodów (wyprowadzenia prądowe).
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Moduł fotowoltaiczny i układ MPPT

 1. Odczytać i zanotować nominalne napięcie rozwarcia modułu PV.

 2. Umieścić moduł PV w naświetlarce.

 3. Do wyprowadzeń napięciowych z modułu PV przyłączyć woltomierz.

 4. Włączyć lampy ustawiając moc na 290 W.

 5. Poprzez interfejs szeregowy przyłączyć układ MPPT do jednego z portów COM komputera.

 6. Uruchomić program HyperTerminal i utworzyć nowe połączenie poprzez użyty port, z prędkością 
transmisji 9600 bd, bez kontroli transmisji (sterowania przepływem) i z domyślnymi pozostałymi 
parametrami.

 7. W programie HyperTerminal wybrać File ‣ Properties ‣ Settings i upewnić się, że ustawiony jest 
maksymalny możliwy rozmiar bufora (Backscroll buffer lines) – 500 linii.

 8. Do zacisków 12 V układu MPPT doprowadzić zasilanie z zasilacza napięcia stałego. Załączenie 
zasilacza powinno spowodować wyświetlenie nagłówka na terminalu.

Obciążenie

 9. Skonfigurować obciążenie elektroniczne:

 a) załączyć jego zasilanie;

 b) na module głównym przyciskiem Chan wybrać numer wykorzystywanego kanału;

 c) wcisnąć Mode i strzałkami  wybrać tryb stałej rezystancji CRL, zatwierdzić przyciskiem Enter;

 d) wpisać podane wyżej rezystancje: jako CRL1 – wartość podstawową, jako CRL2 – wartość 
alternatywną;

 e) na panelu używanego kanału przyciskiem A/B wybrać rezystancję podstawową CRL1, tj. opcję A, o 
czym świadczy świecenie kontrolki przycisku A/B.

 10. Połączyć obwód prądowy:

 a) przyłączyć obciążenie elektroniczne do wyjścia układu MPPT, zwracając uwagę na polaryzację w 
przypadku obciążenia elektronicznego;

 b) ujemne wyprowadzenie prądowe modułu PV (zgodnie z   polaryzacją wskazywaną przez 
woltomierz) połączyć z zaciskiem „−” wejścia układu MPPT;

 c) dodatnie wyprowadzenie prądowe modułu PV połączyć z amperomierzem;

 d) przygotować połączenie amperomierza z zaciskiem „+” wejścia układu MPPT, jednak na razie nie 
dokonywać tego połączenia, tak aby moduł pracował w stanie rozwarcia.

 11. W przypadku korzystania z fizycznego modelu akumulatora, zestawić (nie podłączać do układu 
pomiarowego) odpowiedni układ z zasilacza prądu stałego, diody dużej mocy na radiatorze, 
kondensatora 100…1000 µF i opornika o podanej wyżej wartości.

B. Pomiary dla odbiornika o charakterze rezystancyjnym

Metoda wspinania

 1. Zaczekać na ustabilizowanie się temperatury modułu, o czym świadczyć będzie stabilizacja jego 
napięcia rozwarcia mierzonego obecnie woltomierzem.

 2. Uaktywnić obciążenie elektroniczne przyciskiem Load na panelu wykorzystywanego kanału.

 3. Przyłączyć biegun dodatni modułu PV przez amperomierz do zacisku „+” wejścia układu MPPT. Przy 
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odłączaniu należy postępować w odwrotnej kolejności (tj. najpierw odłączyć moduł, potem 
dezaktywować wyjście obciążenia elektronicznego); w przeciwnym razie na wyjściu układu MPPT 
niepotrzebnie pojawi się dość wysokie napięcie (~50 V).

 4. Dokonać pomiarów zmieniając moc lamp od 290 W do 520 W i z powrotem (przed wykonaniem 
niniejszego punktu należy najpierw przeczytać wszystkie podpunkty):

 a) w każdym punkcie (mocy lamp):

• mierząc zgrubnie czas, zaczekać na względne ustabilizowanie punktu pracy układu MPPT w 
maksimum mocy (najlepiej obserwować w tym celu terminal – moc przez dłuższy czas nie 
powinna zmieniać się w górę);

• zapisać z terminala dane Upv, Ipv, UL w punkcie o maksymalnej mocy Ppv;

• przejść do następnego punktu pomiarowego, zachowując w przybliżeniu jednakowy odstęp 
czasowy, tak aby grzanie modułu postępowało regularnie (nie jest natomiast wymagana 
stabilizacja jego temperatury);

 b) dla maksymalnej mocy lamp:

• przełączyć się na alternatywną rezystancję odbiornika CRL2 (opcja B na obciążeniu 
elektronicznym),

• powtórzyć ppkt a (wyłącznie dla podanej wyżej mocy lamp, tj. maksymalnej),

• powrócić do podstawowej rezystancji odbiornika CRL1 (opcja A),

• ponownie zaczekać na względne ustabilizowanie punktu pracy układu MPPT na wartości 
maksymalnej,

• zapisać dłuższy czas naświetlania modułu w tym przypadku;

 c) jeżeli grozi przepełnienie terminala (patrz część A pkt 7) – zapisać jego zawartość (patrz pkt 5).

 5. Zapisać zawartość terminala – skopiować do schowka (menu Edit ‣ Select All, Edit ‣ Copy), a następnie 
wkleić do programu Notatnik.

 6. Moc lamp pozostawić na wartości 290 W.

 7. Odłączyć przewody od wejścia układu MPPT, a następnie odłączyć obciążenie elektroniczne od wyjścia 
tego układu.

 8. Zdezaktywować wykorzystywany kanał obciążenia elektronicznego przyciskiem Load.

Metoda ułamka napięcia rozwarcia

 9. Przekonfigurować obciążenie elektroniczne do roli układ MPPT pracującego na zasadzie ułamka 
napięcia rozwarcia:

 a) wykorzystywany kanał przestawić w tryb stałonapięciowy CV (na module głównym przyciskiem 
Chan wybrać numer kanału, następnie wcisnąć Mode);

 b) ustawić napięcie CV1 na 0,75 nominalnego napięcia rozwarcia modułu PV (upewnić się, że wynik 
jest mniejszy od rzeczywistego napięcia rozwarcia wskazywanego na woltomierzu – w 
przeciwnym razie należy przyjąć współczynnik odpowiednio mniejszy od 0,75);

 c) upewnić się, że na panelu używanego kanału wybrane jest napięcie CV1, tj. opcja A.

 10. Zwracając uwagę na polaryzację napięcia, przyłączyć moduł PV poprzez amperomierz do wejścia 
obciążenia elektronicznego.

 11. Obserwując wskazanie woltomierza, zaczekać na zgrubną stabilizację temperatury modułu.

 12. Uaktywnić obciążenie elektroniczne przyciskiem Load na panelu wykorzystywanego kanału.
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 13. Wykonać serię pomiarów dla tych samych wartości mocy lamp co w pkt. 4 (tj. od 290 W do 520 W i z 
powrotem):

• zapisać dane Upv, Ipv z mierników zewnętrznych (wskazania mierników obciążenia 
elektronicznego mogą być zbyt niestabilne);

• przejść do następnego punktu pomiarowego, odczekawszy zgrubnie taki sam odstęp czasowy 
(w tym dłuższy dla maksymalnej mocy lamp), jak w przypadku metody wspinania, tak by 
uzyskać zbliżone warunki temperaturowe;

• pominąć zmianę rezystancji odbiornika na alternatywną, natomiast uwzględnić odpowiednio 
dłuższy czas pomiaru zanotowany w pkt. 4.b.

 14. Dezaktywować wyjście obciążenia elektronicznego. Moc lamp pozostawić na wartości 290 W.

Bez poszukiwania punktu maksymalnej mocy

 15. Przekonfigurować obciążenie elektroniczne z powrotem do roli odbiornika rezystancyjnego o 
rezystancji podstawowej CRL1 (patrz część A pkt 9.c–e).

 16. Wykonać serię pomiarów powtarzając pkt. 11–14.

C. Pomiary dla odbiornika o charakterze źródła napięcia

Metoda wspinania

 1. Odłączyć wejście obciążenia elektronicznego od modułu PV. Zwracając uwagę na polaryzację, wejście 
to lub fizyczny model akumulatora połączyć z wyjściem układu MPPT poprzez opornik szeregowy o 
podanej wyżej wartości rezystancji szeregowej akumulatora.

 2. Jeżeli w roli odbiornika E wykorzystywane jest obciążenie elektroniczne:

 a) wykorzystywany kanał obciążenia przestawić w tryb stałonapięciowy CV (na module głównym 
przyciskiem Chan wybrać numer kanału, następnie wcisnąć Mode);

 b) wpisać podane wyżej (w części A) napięcia symulowanego akumulatora: jako CV1 – wartość 
podstawową, jako CV2 – wartość alternatywną;

 c) upewnić się, że na panelu używanego kanału wybrane jest napięcie podstawowe CV1, tj. opcja A;

 d) uaktywnić wyjście obciążenia przyciskiem Load na panelu wykorzystywanego kanału.

 3. Jeżeli w roli odbiornika E wykorzystywany jest model fizyczny: na zasilaczu ustawić napięcie 
akumulatora podane wyżej.

 4. Zacisk ujemny modułu PV połączyć z zaciskiem „−” wejścia układu MPPT lub fizycznego modelu 
akumulatora. W przypadku modelu fizycznego, odłączyć jego zacisk „+” od zasilacza.

 5. Powtórzyć pomiary jak w pkt. 1–8 z części B, stosując odstępy czasowe jak dotychczas, przy czym:

• w przypadku fizycznego modelu akumulatora, zamiast aktywacji/dezaktywacji wyjścia 
przyciskiem Load, należy przyłączyć/odłączyć model do/od zacisku „+” zasilacza;

• jeżeli pkt 4.b (z części B) został już wykonany dla odbiornika rezystancyjnego, należy go 
pominąć; w przeciwnym razie należy go wykonać, przełączając się odpowiednio na napięcie 
alternatywne CV2 (opcja B).

Bez poszukiwania punktu maksymalnej mocy

 6. Zwracając uwagę na polaryzację napięcia, przyłączyć moduł PV poprzez amperomierz do wejścia 
obciążenia elektronicznego (pozostawiając w obwodzie także szeregowy opornik odzwierciedlający 
rezystancję szeregową akumulatora) lub do zacisków modelu fizycznego.
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 7. Wykonać serię pomiarów powtarzając pkt. 11–14 z części B (w przypadku fizycznego modelu 
akumulatora stosując się do uwagi zamieszczonej w pkt. 5 powyżej).

Zakończenie pomiarów

 8. Odłączyć od układu odbiornik.

 9. Wyłączyć lampy.

 10. Wyłączyć zasilanie poszczególnych urządzeń i rozłączyć układ.

D. Opracowanie wyników

 1. Przeanalizować działanie układu poszukiwania punktu mocy maksymalnej według metody wspinania:

 a) na podstawie zapisanej zawartości terminala dla odbiornika rezystancyjnego i metody wspinania, 
wykreślić (w razie potrzeby należy ograniczyć przedział czasu):

• moc modułu Ppv i współczynnik wypełnienia D w funkcji czasu (kolejne próbki z terminala);

• trajektorię punktu pracy modułu fotowoltaicznego (Upv, Ipv) na tle wcześniej zmierzonych 
nieizotermicznych charakterystyk modułu Ipv = f(Upv) dla różnych mocy lamp naświetlających;

• trajektorię punktu pracy modułu fotowoltaicznego (Upv, Ppv) na tle nieizotermicznych 
charakterystyk modułu Ppv = f(Upv) dla różnych mocy lamp naświetlających (gdzie Ppv należy 
obliczyć jako Upv∙Ipv);

 b) przeanalizować uzyskane wykresy, w szczególności pod kątem:

• działania zgodnego z zaimplementowaną metodą;

• jakości działania w sensie bliskości ustalonego punktu pracy do punktu mocy maksymalnej 
(wziąć pod uwagę, że możliwe jest wystąpienie rozbieżności wskutek odmiennej temperatury 
modułu);

• zachowania układu w pobliżu ustalonego punktu pracy;

• działania układu po zmianie obciążenia (rezystancji lub napięcia w zależności od charakteru 
odbiornika).

 2. Dokonać analizy uzysku energetycznego dla poszczególnych przypadków odbiorników i metod 
poszukiwania punktu maksymalnej mocy:

 a) na podstawie zanotowanych wyników Upv, Ipv dla różnych mocy lamp naświetlających, dla każdego 
przypadku odbiornika i każdej metody MPPT (w tym braku MPPT) obliczyć moc modułu Ppv;

 b) na nieizotermiczne charakterystyki modułu Ipv = f(Upv) dla różnych mocy lamp naświetlających, 
nanieść:

• prostą pracy odbiornika rezystancyjnego (którą należy najpierw w tym celu obliczyć),

• punkty pracy modułu (Upv, Ipv) dla kolejnych mocy lamp naświetlających, dla tego odbiornika, 
dla 3 przypadków MPPT (metoda wspinania, metoda ułamka napięcia rozwarcia;

 c) utworzyć tabelę z wartościami mocy oświetlenia i mocy modułów Ppv dla 3 przypadków MPPT, a 
następnie:

• kolejnym wartościom mocy oświetlenia (rosnącym a następnie malejącym) należy 
przyporządkować określony, realny przedział godzin w ciągu dnia (o długości np. 1h, 2h);

• obliczyć energię Wpv, jaka byłaby pozyskana z modułu dla każdego z przypadków MPPT w 
kolejnych przedziałach godzinowych, gdyby w całym przedziale odbierana była stała moc Ppv;

• obliczyć sumaryczną energię Wd, jaka zostałaby pozyskana z modułu w ciągu całego dnia dla 
każdego z przypadków MPPT;
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 d) przeanalizować otrzymane wartości Wd w związku z tabelą i wykresem, porównując poszczególne 
przypadki MPPT pod względem uzysku energetycznego całkowitego i w poszczególnych 
przedziałach godzinowych (m.in. jak w ciągu dnia zmienia się rozbieżność między mocą odbieraną 
a mocą maksymalną dla danej mocy oświetlenia);

 e) powtórzyć pkt. b–d dla odbiornika o charakterze źródła napięcia (dla 2 przypadków MPPT);

 f) porównać skuteczność obu metod MPPT w obu przypadkach odbiorników.

 3. Przeanalizować wpływ temperatury na uzysk energetyczny:

 a) wykreślić ponownie nieizotermiczne charakterystyki modułu Ppv = f(Upv) dla różnych mocy 
oświetlenia;

 b) nanieść punkty pracy (Upv, Ppv) dla odbiornika rezystancyjnego i metody wspinania;

 c) strzałkami zaznaczyć drogę punktu pracy w ciągu dnia;

 d) stwierdzić, w jaki sposób temperatura wpływa na moc odbieraną z modułu – uwzględniając, że 
podczas nagrzewania temperatura ta była niższa niż podczas chłodzenia dla tych samych mocy 
oświetlenia.

 4. Dokonać analizy działania układu MPPT z metodą wspinania na poziomie bloku systemu 
fotowoltaicznego:

 a) na podstawie zanotowanych wyników w punkcie mocy maksymalnej dla odbiornika 
rezystancyjnego: Upv, Ipv i UL oraz znanej rezystancji odbiornika RL, obliczyć moc wejściową Ppv, 
moc wyjściową PL i sprawność układu ηMPPT;

 b) wykreślić i opisać sprawność ηMPPT w funkcji mocy modułu Ppv;

 c) ponownie wykreślić nieizotermiczne charakterystyki modułu Ipv = f(Upv) i dla każdej mocy 
oświetlenia nanieść na nie:

• punkt pracy modułu (Upv, Ipv),

• hiperbolę I∙U = Ppv = UpvIpv, w którym to celu należy obliczyć odpowiedni zbiór punktów (U, I),

• punkty pracy odbiornika (UL, IL), do czego niezbędne będzie obliczenie prądu IL;

 d) na podstawie uzyskanego wykresu wykazać zgodność działania układu z ogólną zasadą działania 
układów MPPT (uwzględnić, że mogą wystąpić rozbieżności wynikające z wcześniej wyznaczonej 
sprawności przetwornicy).
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